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(v5.0 September 2016)

COMPETITION OVERVIEW

PREPARING DIGITAL FILES FOR PROJECTION

This booklet is intended to help members to prepare competition entries. All members
should have received a copy of the ‘Constitution and Rules’ leaflet. Competition rules from
that leaflet are repeated here, alongside information on preparing digital files.
Members are encouraged to enter club competitions. Judges are asked to give positive
information to try to help the author improve their photography. Entries only bear the authors
membership number so that entries remain anonymous – unless the judge is sufficiently
pleased with the image to award it a credit. If a credit is awarded the author’s name is
announced.
Please note that for the Monthly Competitions you cannot re-enter an image which has
ever received a credit in ANY category except that a colour image which has received
a ‘Credit’ in the Colour Print or DPI sections can be entered as a Monochrome Print in
a subsequent year.
In the Annual you cannot re-enter an image which has been accepted in one category
in ANY OTHER category, except that a colour image accepted in the Colour Print or
DPI sections can be re-entered as a Monochrome Print. Also you cannot enter the
same image in more than one category of the same year’s Annual Exhibition.
There are some rules which apply throughout all competitions.
1. Entries must originate as photographs (image-captures of objects via light
sensitivity) made by the member on photographic emulsion or acquired digitally.
Images may be altered – electronically or otherwise – by the member. The member
must own the copyright for all parts of the images submitted
2. All prints must be printed by the author. The use of self-service printing booths is
allowed but you must make all changes yourself. You must check that no-one else
will be making any adjustments to your files before or during printing.
3. The maximum print size – including mount – must be no more than 16” x 20”
(400mm x 500mm). This is because they must fit in the print box to be sent to
the judge. Oversize prints will be rejected.
4. Digital files should be a maximum of 1400 pixels wide and a maximum of 1050
pixels high. If one dimension is smaller that area will be filled automatically with a
black border. There is no need for you to add one.
5. The following requirements apply to all digital projected image entries.
Set the colour space as sRGB.
Set mode to 8 bit colour or 8 bit greyscale
Flatten the image and save as JPEG or tiff image. Make sure tiff files are 8 bit
6. The file naming convention for digital files can vary between one competition and
another. Please check carefully.
7. Slide mounts should be labelled with the image title and your membership number
(your name must not appear).
8. Entries for all competitions have to be handed in by the date listed on your
membership card. If in doubt please check with the Competition Secretary.
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These notes are to help with preparing digital files for entry to DCC competitions.
ALWAYS READ THE RULES. Failure to do this can cause images to be disqualified
or they may not display properly.
In the following instructions for Photoshop and Elements instructions are given for both
programs with the instructions for Elements in red where they differ from those for
Photoshop.
You will be asked to control the following:
1. The colour space sRGB must be used. If you do not set the correct colour space
the colours of your image may not display correctly.
In Photoshop or Elements
Edit > Assign Profile
Under ‘Profile’ select drop down menu and select sRGB IEC61966-2.1
Then Click OK.
Image > Convert Colour Profile > Convert to sRGB Profile
2. Always flatten the image if you have used layers.
In Photoshop or Elements
Layers>Flatten Image
Layer > Flatten Image
3. The mode – usually RGB Colour,8 bits only OR Greyscale 8 bits
Image > Mode
Then select both RGB and 8 bit
Image > Mode > RGB Colour
4. The image size. The club’s projector (and the one used by the SPF) has a
resolution of 1400 wide by 1050 high.
In Photoshop or Elements
Adjust the number of pixels along the longest dimension of your image.
Image >Image Size
Image>Resize>Image Size
Make sure the ‘constrain proportions box is ticked.
Pixel dimensions are in the upper box.
Change width to 1400 for a landscape format image.
Change the height to 1050 for a portrait format image.
Check that the dimension which has changed automatically is within the permitted
limits.
Save your image
JPEG (jpeg) files must be 8 bit. If JPEG does not appear in the drop down menu of
file types when you are saving the image you have forgotten to change the mode to
8 bit! Use the highest quality setting (usually 12) to save your images.
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JPEG uses a ‘lossy’ compression and higher compression ratios can reduce the
quality of your images when projected.
TIFF files use a ‘loss-less’ compression but must not be compressed for
competitions. The file size is much bigger than for JPEG images. Only 8 bit
TIFFS can be used – our software does not accept 16 bit images.
Both TIFF and JPEG images are accepted for club competitions. When
submitting images for use as part of a club entry to external competitions TIFF
images are preferred as some competitions may ask for a different file size. It is
better not to have to re-JPEG a file as quality can be reduced when projecting
the image.
Create a folder for your images. Read the rules for the competition to check
how to name the folder. This can vary for different competitions.
Open the folder to save your image. Type in the name of your file as specified
in the competition rules. The software used by DCC takes information from the
folder name and the file name and enters them into a spreadsheet. This saves
the competition secretary a lot of work. It does not take long for each member to
name their own folders and files, but it can take a very long time for the
competition secretary to correct everybody’s errors.
5. Writing a CD
The CD has to be read in a computer other than your own.
DO NOT USE MULTISESSION
Discs must be ‘to be read on any computer’, ‘write at once’ and you must ensure
that the ‘session is closed’.
Do not use labels on the CD – write your name on it with permanent marker pen.
You may also be asked for a competition number, address, and postcode or
phone number.
DEFINITION OF A MONOCHROME (BLACK AND WHITE) IMAGE
An image containing shades varying from very dark grey (black) to the very clear
grey (white) is a monochrome work. A black and white work toned entirely in a
single colour will remain a monochrome work and can be entered in the black and
white category. On the other hand a black and white work modified by a partial
toning or by the addition of one colour becomes a colour work (polychrome) and
must be entered in the colour category
PRESENTATION OF PRINTS FOR COMPETITIONS
1. All prints must be mounted.
2. Maximum size including mount is 20” x 16” (500mm x 400mm).
3. The following information must be clearly written on the back of the print:Name of competition and category entered
Section (if applicable)
Membership number of author
Title of image
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NATURE
There is a nature definition which applies to nature competitions only.
Combined FIAP, PSA, PAGB and RPS Nature Photography Definition
NATURE PHOTOGRAPHY is restricted to the use of the photographic process to
depict all branches of natural history, except anthropology and archaeology, in such
a fashion that a well-informed person will be able to identify the subject material
and certify its honest presentation. The story telling value of a photograph must be
weighed more than the pictorial quality while maintaining high technical quality.
Human elements shall not be present, except where those human elements are
integral parts of the nature story such as nature subjects, like barn owls or storks,
adapted to an environment modified by humans, or where those human elements
are in situations depicting natural forces, like hurricanes or tidal waves. Scientific
bands, scientific tags or radio collars on wild animals are permissible. Photographs
of human created hybrid plants, cultivated plants, feral animals, domestic animals,
or mounted specimens are ineligible, as is any form of manipulation that alters the
truth of the photographic statement. No techniques that add, relocate, replace, or
remove pictorial elements except by cropping are permitted. Techniques that
enhance the presentation of the photograph without changing the nature story or
the pictorial content, or without altering the content of the original scene, are
permitted including HDR, focus stacking and dodging/burning. Techniques that
remove elements added by the camera, such as dust spots, digital noise, and film
scratches, are allowed. Stitched images are not permitted. All allowed adjustments
must appear natural. Colour images can be converted to greyscale monochrome.
Infrared images, either direct-captures or derivations, are not allowed. Images used
in Nature Photography competitions may be divided into two classes; Nature and
Wildlife. Images entered in Nature sections meeting the Nature Photography
Definition above can have landscapes, geological formations, weather phenomena,
and extant organisms as the primary subject matter. This includes images taken
with the subjects in controlled conditions, such as zoos, game farms, botanical
gardens, aquariums and any enclosure where the subjects are totally dependent on
man for food. Images entered in Wildlife sections meeting the Nature Photography
Definition above are further defined as one or more extant zoological or botanical
organisms free and unrestrained in a natural or adopted habitat. Landscapes,
geological formations, photographs of zoo or game farm animals, or of any extant
zoological or botanical species taken under controlled conditions are not eligible in
Wildlife sections. Wildlife is not limited to animals, birds and insects. Marine
subjects (plus fungi and algae) taken in the wild are suitable wildlife subjects, as are
carcasses of extant species. Wildlife images may be entered in Nature sections of
Exhibitions.
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MONTHLY COMPETITIONS
RULES
Three Sections will operate and members will be assigned to one (the same will
apply to all three categories):
General Section: members in the first few years of entering competitions and
new members with little or no previous club experience.
Intermediate Section: members who have more experience and have entered
competitions for several years, including members achieving LRPS.
Advanced Section: skilled photographers with appropriate skill level and/or
photographic honours such as ARPS, BPE* awards, AFIAP and CPAGB (or
higher levels) would automatically be put in this section.
Members who are new to photographic competitions may elect to have their
beginner’s status indicated to the judge by placing a (B) after the member
number (see rule 12).
2. Three Categories will operate Mono Prints, Colour Prints and Digital Projected
Images.
3. Members can enter up to 3 images in each category, with a maximum of 4 in
any one Monthly Competition.
4. Judges, whenever possible will be selected from outwith the club and will be
asked to award credits.
5. If a Judge fails to appear, the Committee reserves the right to use alternative
methods of judging.
6. No late entries will be accepted.
7. An image can be used in more than one monthly competition provided it has
not been awarded a credit. However, no print or digital projected image can be
submitted more than 3 times in Monthly Competitions.
8. An image, or significantly similar image, which has gained a Credit may not be
used again in any category except that a colour image which has received a
‘Credit’ in the Colour Print or DPI sections can be entered as a Monochrome
Print in a subsequent year.
9. Entries must originate as photographs (image-captures of objects via light
sensitivity) made by the member on photographic emulsion or acquired
digitally. Images may be altered – electronically or otherwise – by the member.
NB See definitions for Nature images. The member must own the copyright for
all parts of the images submitted.
10. Negatives may be home or commercially processed.
11. Mono and Colour print categories must be printed by the author on
photographic or electronic print material.
12. All prints should be mounted and be not greater than 16” x 20” including the
mount. Double mounts and heavy backing boards should be avoided.
1.
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13. Prints must bear the following information: Section entered, title and Member’s
number and where appropriate (B).
Digital entries must bear the Section entered and Member’s Number on the
CD. See current instructions issued by the Competition Secretary
14. The winner or tied winners of the General and Intermediate sections must
move up a section if they achieve 7 or more Credits in that Section. Winners
with less than 7 credits will be invited to move up a section if they so wish.
15. The member(s) with the lowest score(s) in the Intermediate and Advanced
Sections will move down a Section at the discretion of the Committee.
16. New Members will be placed in the most appropriate ‘Section’ based on the
standard in photography that they have reached.
When New Members join they are to be asked to provide the Competition
Secretary with appropriate information of any previous Camera/Photographic
Clubs of which they have been a member, any photographic qualifications they
hold and indicate if they have had acceptances in any National or International
Exhibitions.
17. Members may not submit an image or a significantly similar image in more
than one category in the same monthly competition.

DIGITAL FILE INSTRUCTIONS
Please note that ALL files MUST have a title and it is important to
follow the instructions below. If you have difficulty please ASK.
Prepare files with maximum 1400 pixels horizontally and maximum 1050 pixels
vertically, sRGB colour space, 8 bit colour, Tiff or JPEG.
For monthly competitions your files (Maximum of 3) should be named:
1_Title
2_Title
3_Title
Place all the files in a folder – the folder title is your name.
Write to a CD.
Label the CD with your name with a marker pen.
Do not attach any labels to the CD.
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1.

2.
3.
4.

5.
6.

7.
8.
9.

PORTFOLIO COMPETITION

ANNUAL EXHIBITIONS

RULES

RULES

There are 2 Portfolio competitions. The Projected Image Portfolio consists of
6 PDI’s on a theme of the author’s choice and the Print Portfolio consists of 6
prints on a theme of the author’s choice. Members can enter both
competitions but the themes and all images must be different.
Projected Images or prints which have been entered or credited in Monthly
Competitions are eligible.
A judge will be selected by the Committee and invited to select a winner in
the print and Projected Image category and will award trophies accordingly.
Entries must be anonymous. Prints must be hung before the arrival of the
judge. Projected Images will be sent to the judge in advance and must be
numbered 1 to 6.
Only one section will operate in the competition.
Entries must originate as photographs (image-captures of objects via light
sensitivity) made by the member on photographic emulsion or acquired
digitally. Images may be altered – electronically or otherwise – by the
member. The member must own the copyright for all parts of the images
submitted.
Negatives and slides may be home or commercially processed.
Mono and Colour Prints must be printed by the author on photographic or
electronic print material.
All digital files must be presented as in current instructions issued by the
Competition Secretary.

DIGITAL FILE INSTRUCTIONS FOR PORTFOLIO
Name the folder with the portfolio title, followed by an underscore and your name.
Number the images from 1 to 6 followed by underscore then the title. Images
should be numbered in the order in which they should be projected.
If you do not have individual titles for the images just name each one
‘untitled’ followed by a sequence number as below. (Every file MUST have an
individual title for the programme we use to run the competition.)
E.g.
Folder
The Life of Insects_Lesley Simpson
Images
1_Butterfly
2_Emerging Dragonfly
3_Untitled 1
4_Untitled 2
5_Untitled 3
6_Untitled 4

1.

The Annual Exhibition will be in two parts—one for Prints and one for Projected
Images. Each member may enter up to eight prints (subject to a maximum of
six mono or six colour prints) into the Print Exhibition. The Maximum size of
prints shall be 16” x 20” including the mount.
2. Each member may enter up to eight digital files or 2”x2” slides into the
Projected Image Exhibition.
3. An image, or significantly similar image, once accepted in the Annual cannot be
used again in any subsequent Annual Exhibition in any category, except that a
colour image accepted in the Colour Print or DPI sections can be re-entered as
a Monochrome Print.
Images which have been entered in or won other
competitions (e.g. Monthly, Nature) can be entered in the Annual Exhibition.
4. Members may not enter the same image into more than one category (i.e.
Monochrome Prints, Colour Prints or DPI) 0f the same year’s Annual Exhibition.
5. Judges will be picked by the committee and invited to select 50 –60 prints
(approximately in proportion to the colour/mono entry) and 50—60 Projected
Images to form the Annual Exhibition
6. Judges will also be invited to name the first and runner up in each subject
together with the top three Monochrome Prints, the top three Colour Prints and
the top three Projected Images in that exhibition.
7. Only one section will operate in the Annual Exhibition.
8. The subjects are: - Pictorial, Portraiture, Action/Sport, Creative, Nature and
Landscape.
9. Entries must originate as photographs (image-captures of objects via light
sensitivity) made by the member on photographic emulsion or acquired digitally.
Images may be altered – electronically or otherwise – by the member. The
member must own the copyright for all
parts of the images submitted.
10. Negatives and slides may be home or commercially processed.
11. Mono and Colour Prints must be printed by the author on photographic or
electronic print material.
12. All digital files must be presented as in current instructions issued by the
Competition Secretary.

DIGITAL FILE INSTRUCTIONS – FILE NAMING
The program we use for the projected images has a facility to sort the images into
the different categories so please follow the following instructions for your digital
images. These instructions will also be on the reverse of the entry form.
All images must have a title.
9
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Please prepare the files themselves as for the Monthly Competitions. However
they must be titled and written to disc as follows.
1. Do NOT place the files into a folder just place them on the disc.
2. Title them as below.
Category_ Title_Entrants Name
Please note – there are no spaces between Category, Title and Entrant
Name – just the underscore.
Please type the title correctly as any spelling mistakes or typos will go to the
judge!
e.g. Landscape_Moray Firth Sunset_John Smith
Portraiture_Fringe Performer_John Smith
Nature_Blackbird_John Smith

IT’S A KNOCKOUT
This is light-hearted competition.
As for all competitions entries may be handed-in as slides or digital files.
However, all slides will be scanned and the competition will be held in digital
format only.
Digital files must be at a maximum resolution of 1400 x 1050 and prepared as for
all club competitions.
All entries should be work not previously used in club competitions.
All images must be handed in, in advance (see list of handing in dates.)
Members can enter a maximum of 6 files.

If you follow the instructions the software will do all the work – not the Competition
Secretary. It doesn’t take long to prepare your entry correctly – it could take the
Competition Secretary hours to prepare entries for the judge if you do not!!
1.
2.
3.

SET SUBJECT CHALLENGE (MINI COMP) - RULES
1.
2.
3.
4.
5.
6.
7.

8.
9.

One section will operate in the ‘Set Subject Challenge’ competition.
The “Set Subject Challenge” is a competition open to all members.
Two categories will operate, Projected Digital Images and/or Unmounted
Prints, up to a maximum size of A4.
Members may submit one image per subject per category. i.e. any image
submitted as a PDI may not be submitted as a print and visa versa.
Images which have been previously entered or credited in a Monthly
Competition ARE eligible.
Three subjects for the Competition will be selected annually.
The Competition will be judged on the night with a score being awarded to
each image. The highest total aggregate in each category (i.e. PDI’s or Prints)
will decide the winner.
All digital files must be presented as in current instructions issued by the
Competition Secretary.
All images (PDI and Prints) must be handed in one week in advance. (A
maximum of 3 PDI’s and/or 3 Prints).

FILE NAMING
1.
2.
3.
4.

FILE NAMING

4.

1.
2.

3.

Make a folder titled with your name.
Give each file a title.
Name your files as follows:
1 Title
2 Title
3 Title
4 Title etc.
Individual titles are required for all images.
Save your files into the folder and write to disk. Label the disk with your
name and membership number. Use permanent marker – no labels
please.
NATURE COMPETITION
Nature is a standalone competition.
Images will receive Commended and Highly Commended awards from the
st
nd
rd
judge, along with 1 , 2 and 3 in each section (Monochrome, Colour Prints
and Projected Digital Images.
The results of the Nature competition will not go towards the Photographer of
the Year results.

PHOTOGRAPHER OF THE YEAR

Create a separate folder for each subject – titles with subject name.
Place one file in each folder.
Title of files to be as follows:
Image title_your name
Write to disc and label with your name and membership number.

The “Photographer of the Year” award is given to the member who has the
highest total of “Credits” in the season, across all sections.

11
12

